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Make your chart labels in Microsoft Excel dynamic by linking them to cell values. When the data changes, the chart labels automatically update. In this article, we explore how to make both your chart title and the chart data labels dynamic. We have the sample data below with product sales and the difference in last month's sales. We want to chart
the sales values and use the change values for data labels. Use Cell Values for Chart Data Labels Select range A1:B6 and click Insert > Insert Column or Bar Chart > Clustered Column. The column chart will appear. We want to add data labels to show the change in value for each product compared to last month. Select the chart, choose the "Chart
Elements" option, click the "Data Labels" arrow, and then "More Options." Uncheck the "Value" box and check the "Value From Cells" box. Select cells C2:C6 to use for the data label range and then click the "OK" button. The values from these cells are now used for the chart data labels. If these cell values change, then the chart labels will
automatically update. In addition to the data labels, we want to link the chart title to a cell value to get something more creative and dynamic. We will begin by creating a useful chart title in a cell. We want to show the total sales in the chart title. In cell E2, enter the following formula: ="Monthly Sales Total - "&TEXT(SUM(B2:B6),"0,###") This
formula creates a useful title that combines the text "Monthly Sales Total - " to the sum of values B2:B6. The TEXT function is used to format the number with a thousand separator. We now need to link the chart title to cell E2 to use this text we've created. Click the chart title, enter = into the Formula Bar, and then click cell E2. From there, press the
Enter key. The value from cell E2 is used for the chart title. If the values in the data range were to change, our data labels and chart title would update to reflect that on the chart. Using creative and dynamic labels for your charts, by basing them on cell values, will take your charts beyond the standard charts others create in Excel. Adding data to a
chart in Microsoft Excel is a fundamental skill that can help you create clear and visually appealing charts and graphs. Whether you want to include new data in an existing chart or create a new chart from scratch, the process is straightforward and customizable to your specific needs. In this post, we will walk you through the steps of adding data to
a chart in Excel so that you can present your data in the most effective way possible. Select Your Chart Before you can add data to a chart, you must select the chart that you want to work with. If you have not yet created a chart, you will need to do so before proceeding. Once you have selected the chart, you can begin to add data to it. Open the
Chart Data Source To add data to a chart in Excel, you will begin by opening the chart data source. This will display the spreadsheet that the chart is based on, which is where you can update the data that appears in the chart. Option 1: Open the Data Source from the Ribbon If you are using Excel 2010 or later, you can open the chart data source by
clicking on the chart and then selecting the “Chart Tools” tab from the ribbon. From there, click on the “Edit Data” button to open the data source. Option 2: Open the Data Source from the Context Menu If you prefer to use the context menu to access commands in Excel, you can right-click on the chart and select the “Edit Data” option. This will open
the data source in a new window. Add Data to the Chart Once you have opened the chart data source, you can begin to add data to the chart. Depending on how your chart is set up, you may be able to add data simply by typing it into the spreadsheet, or you may need to follow a more formal process. Option 1: Type Data Directly into the Spreadsheet
If you have a simple chart that only requires a few data points, you can add data to the chart by simply typing it directly into the spreadsheet. To do this, click on the cell where you want to add the data and type the value. Option 2: Use the Series or Category Options to Add Data If you have a more complex chart that requires additional data points,
you can use the Series or Category options to add data. To do this, click on the chart and select the “Chart Tools” tab from the ribbon. From there, click on the “Select Data” button and choose either the “Series” or “Category” option, depending on what type of data you want to add. This will open a new window where you can enter your data. Save
and Update the Chart Once you have added your data to the chart, you can save and update the chart to ensure that the new data is reflected in the chart. To save the chart, simply click on the “Save” button in the Excel ribbon. To update the chart, click on the chart and select the “Chart Tools” tab from the ribbon. From there, click on the “Refresh
Data” button to update the chart with the new data. Customize Your Chart Adding data to a chart in Excel is just the first step in creating a powerful visual. Once your data is in place, you can begin to customize the chart to make it more visually appealing and effective. Here are some tips for customizing your chart: Change Chart Type If you find that
your data is not displaying effectively in its current chart type, you can easily change the chart type to better fit your data. To do this, click on the chart and select the “Change Chart Type” button in the Excel ribbon. From there, select a new chart type and finalize the changes. Add Titles and Labels A clear and well-labeled chart can make all the
difference in effectively communicating your data to others. To add labels and titles to your chart, click on the chart and select the “Chart Tools” tab in the Excel ribbon. From there, you can add chart titles, axis labels, and more. Change Colors and Styles Changing the colors and styles in your chart can make it easier to read and can help to
emphasize important data points. To change the colors and styles in your chart, click on the chart and select the “Chart Tools” tab from the ribbon. From there, you can adjust the colors and styles to better fit your data. Conclusion Adding data to a chart in Excel is a fundamental skill that can help you present your data in a clear and visually
appealing way. By following the steps we’ve outlined in this post, you can easily add data to any chart in Excel and customize it to fit your specific needs. With the right chart and data, you can present your findings to your colleagues or clients with ease. FAQs We understand that adding data to a chart in Excel can be confusing, so we’ve put together
a list of frequently asked questions to help you get the most out of your Excel charts. Can I add data to an existing chart in Excel? Yes, you can add data to an existing chart in Excel by selecting the chart, opening the data source, and adding new data to the spreadsheet. Your chart will update automatically once you’ve added your new data. How do I
select the chart I want to add data to? To select the chart you want to add data to, simply click on the chart you want to work with. This will allow you to begin adding data to the chart. What should I do if my data is not displaying correctly in my chart? If your data is not displaying correctly in your chart, you may need to change the chart type or
adjust some of the chart settings. Try experimenting with different chart types to see what works best for your data. Can I change the colors and styles in my chart? Yes, you can change the colors and styles in your chart to better fit your needs. To do this, click on the chart and select the “Chart Tools” tab from the ribbon. From there, you can adjust
the colors and styles of your chart. How do I save and update my chart? To save your chart, click on the “Save” button in the Excel ribbon. To update your chart, click on the chart and select the “Chart Tools” tab from the ribbon. From there, click on the “Refresh Data” button to update the chart with the new data. We have a dataset of sales for sales
assistants who work at a shop over a certain period of time. We have made a chart describing the sales of these representatives over the time period mentioned. Add a new data column to your previous data set (i.e. sales of Stephen). Click the chart area, and you’ll see the data source which is currently displayed is selected on the worksheet, but the
new data series is not selected. Drag the sizing handles to include the new data series and the chart will update. Read More: How to Expand Chart Data Range in Excel Method 2 - Add Data to an Existing Chart on a Separate Worksheet Right-click on the chart and click Select Data. A dialogue box will show up. Click Add on the Legend Entries
(Series) box. Go to the sheet containing the new data entries. Assign a new Series name (i.e. Stephen). Assign the cells containing new data entries as the Series values. The heading of the new data entries will show up on the Legend Entries box. Click OK on the dialogue box. Your existing chart will show the updated data. Read More: Selecting Data
in Different Columns for an Excel Chart Method 3 - Update Data to a Chart by Pasting New Entries Copy the new data entries of the dataset. Click on the chart and paste. Your chart will be updated. Read More: How to Select Data for a Chart in Excel Method 4 - Use the Paste Special Option to Add Data to a Chart Copy the new data entries and click
on the chart. Go to the Home tab, select Paste, and click Paste Special A dialog box will show up displaying multiple options for you for full control of what is pasted. Choose the options you want and your updated chart will be ready. Method 5 - Use a Pivot Table to Add Data to an Existing Chart Select the data range. Go to the Home tab and click
Format as Table. Choose a design for the table. The Create Table dialogue box will show up. Mark if your table has headers. Click OK. Your table will be created. Go to the Insert tab, click Pivot Table, and select From Table/Range. Choose whether you want your pivot table on the same sheet or a different sheet. A PivotTable Fields box will show up.
Drag your data range to the drag fields you want (i.e. drag Month to Rows) Drag the other data ranges to the other drag field (i.e. Mike and Adam to Values) Go to the Pivot Table Analyze tab and select Pivot Chart. Create a chart (i.e. Clustered Column) Your sheet will show the chart. Drag your new data entries to the field (i.e. Stephen to Values).
Your chart will show the added new data entries. Download the Practice Workbook Add Data to an Existing Chart.xlsx Related Articles Insert > Template to open the template library. Browse the categories on the left and select a template on the right. Click on the magnifying glass to see a larger preview. Click Insert to add it to the drawing canvas.
Tip: You can also generate a custom smart template from a text description of your particular diagram via the draw.io template library. Either click on Generate in the Basic section of the library, or go to the Smart Templates section. Learn more about smart diagram generation in draw.io Shapes for different types of diagrams You can create abstract
line charts and bar graphs using the infographic shape library. However, as the draw.io editor is not connected to a form of numerical data input, creating exact graphs from quantitative data is better done in a spreadsheet. Click on More Shapes at the bottom of the Shapes panel. Enable the checkboxes next to the shape libraries you want to use, and
click Apply. Follow us on GitHub, Twitter, Facebook. Right click on a chart and select ‘Establish Excel link’Select the cells in Excel with data to link toClick ‘OK’ to link the chart with Excel as shown by the path in the top right cornerWas this article helpful?Related Articles In Excel, unless you have a dynamic data set, or your data is an Excel table,
then you may need to manually add data to your existing Excel chart if you want to display more data than your original chart displays.Here are four great and easy ways to get more data into your exiting Excel chart.Firstly we can create a default chart really quickly by selecting your data and hitting ATL+F1.. Excel will put a chart on your existing
worksheet you are on. Handy....so we have our basic chart.So- onto getting some new data into our brand new Excel chart. I said 4 ways so let’s start with the first.1. Copy Your Data & Click On Your ChartSo, let’s add in some more data- another line in Row 10.Click on the outside of your chartHit PasteYour chart will update. Easy as that.2. Using
Copy and Paste SpecialThis second method gives you even more control as you can hit Copy and then again click on the edge of chart but then just select Paste Special and there you complete control of what is pasted.Excel will display multiple options for you for full control of what is pasted3. Drag The Data Finder EdgesOk, third method. When you
click on your chart, you will see the data in your chart highlighted in your data source usually the edges will be coloured as below.All you need to do then is drag the edge of the range finder to include your new data. Easy. Your Chart will update4. Using The Fill SeriesI never use this method very much as it is a bit long winded, but you can use it as
a method to add data to your chart.Right click on the chartSelect the Select Data option, or go to the Design tab and on the Data group click on the Select Data button.A Select Data Source dialog box opens and the chart source range get’s highlighted with the ‘marching ants’ as we like to call them. Click the Chart data range field and select the new
data range.Click the OK button and your chart will be updated with the new data. I this case it is B4 To E10There you are 4 ways to add new data to an existing Excel Chart.If you want more Excel solutions to formulas and charting then I recommend Excel School -A structured and comprehensive online training program for learning Microsoft
Excel. It is full of real world examples to work through.link to How To Add A Dynamic Horizontal Target Line To An Excel Chartlink to How To Write Excel Macros For Beginners Excel is a tool that many of us use, whether it's for work, school, or just keeping track of personal finances. One of its standout features is the ability to create charts that
make data visually appealing and easier to understand. But how do you link your data to a chart in Excel? This is what we’ll be focusing on today. By the end of this guide, you'll have a solid understanding of how to connect your data to a chart and make it dynamic, so any changes in your data are automatically reflected in your charts. We'll cover
everything from setting up your data correctly to choosing the right chart type and linking your data step-by-step. You’ll also learn some handy tips and tricks along the way to make your charting experience smoother. So, let’s get started!Build dashboards & reports in seconds with the best Al spreadsheet. Bricks makes creating dashboards, reports,
and charts a breeze. Try it free — Before you even think about creating a chart, it's crucial to have your data properly organized. Imagine trying to build a house on a shaky foundation—it just doesn't work! The same goes for charting in Excel. The way you set up your data can make or break the final outcome of your chart. First, ensure your data is
laid out in a table format. Excel loves tables, and they make it super easy for you to manage your data. Each column should have a clear header, and the data should be consistent. For instance, if you’re tracking sales data, one column could be "Date," another "Product," and a third "Sales Amount." Here are a few tips for organizing your data: Use
Clear Headers: Descriptive headers help you and Excel understand what each column represents. Consistent Data Types: Ensure all data in a column is of the same type (e.g., all dates, all text, or all numbers). Avoid Empty Rows and Columns: These can confuse Excel when it tries to determine the data range for your chart. Once your data is
organized, you're ready to move on to the exciting part—creating a chart!Bricks is an Al-first spreadsheet that makes creating dashboards, reports, and analyzing your data a breeze. Import your data, describe what you want, and improve it by asking for changes.GET STARTED FOR FREE With your data neatly organized, it's time to decide on the
type of chart you want to create. The right chart type can make your data more comprehensible and impactful. Excel offers a variety of chart types, each serving different purposes, so it's important to choose the one that fits your data best. Here’s a quick rundown of some common chart types and when to use them: Column and Bar Charts: Great for
comparing data across categories. Use a column chart if you have fewer categories, and a bar chart if you have many. Line Charts: Perfect for showing trends over time. They're ideal for data that spans across a period. Pie Charts: Useful for displaying parts of a whole. They work best when you have just a few categories. Scatter Plots: Best for
showing relationships between two variables. They help in identifying correlations. Choosing the right chart type can sometimes feel like an art form. It depends on personal preference, but also on how you want your audience to interpret the data. Take a moment to consider what you want to convey before making a choice. Now that you’ve got your
data organized and decided on a chart type, it’s time to create your first chart. This is where the magic happens, and it’s easier than you might think. Here’s a step-by-step guide to creating a chart in Excel: Highlight the data you want to include in your chart. Make sure to include headers if you want them as labels. Navigate to the Insert tab on the
Ribbon. Select the type of chart you want from the Charts group. For instance, if you want a column chart, click on the column icon. Excel will automatically create a chart and place it on your worksheet. You can move it around by clicking and dragging it to your desired location. Voila! You should see your data beautifully displayed in a chart. But
we’re not done yet. The chart might not look exactly how you want, and that's okay. We’ll go over how to customize it next. Once your chart is created, you might want to tweak it to better fit your style or to make the data clearer. Excel provides a range of customization options that let you personalize your charts. Here are some customization
features you can experiment with: Chart Title: Click on the chart title to change it. A descriptive title can help viewers understand the chart's purpose. Legend: Decide whether you need a legend and where you want it placed. This can help in distinguishing different data series. Colors and Styles: Use the Chart Tools on the Ribbon to change the color
scheme or style of your chart. This is a great way to make your charts visually appealing. Axis Titles: If your chart has axes, you can add titles to make it clearer what each axis represents. Data Labels: Add data labels to show the exact values on your chart. This is especially useful for bar and column charts. Play around with these options until you get
a chart that looks just right. Remember, the goal is to make your data as clear and engaging as possible. Now, onto the main event—linking your data to your chart. This is the step that ensures your chart dynamically updates whenever your data changes. It’s like having a chart on autopilot, which is a real-time saver. Here’s how you can link data to
your chart: Click on your chart to select it. You should see the data range highlighted in your worksheet. To alter the data range, click on the Chart Tools tab, then select Design followed by Select Data. In the Select Data Source dialog box, you can adjust the Chart Data Range or add more data series. Click OK once you're satisfied with the new
settings. And just like that, your chart is now dynamically linked to your data. This means any updates you make to the data in your worksheet will automatically reflect in your chart. One of the best things about linking your data to your chart is that it stays updated. But, what if you need to add more data or modify existing entries? The good news is,
Excel handles this pretty smoothly. To keep your chart up-to-date: Adding New Data: Simply extend your data range to include new entries. Your chart will automatically adjust to incorporate the new data. Modifying Existing Data: Change any values in your data table, and watch as your chart updates in real-time. No need to recreate the chart!
Removing Data: If you delete data points, your chart will update accordingly. Just ensure you maintain the integrity of your data range. Excel’s dynamic nature means you can focus on analyzing your data, rather than spending time on repetitive chart updates. If you want to get a bit fancy, you can use dynamic named ranges to make your charts even
more flexible. This technique allows your chart to automatically adjust its data source as you add or remove data. It’s a powerful tool, especially if you're dealing with datasets that frequently change in size. Here's a quick rundown on setting up dynamic named ranges: Go to the Formulas tab and click Name Manager. Click New to create a new
named range. In the Refers to box, use Excel’s OFFSET and COUNTA functions to define a range that adjusts based on the number of filled cells. Use this named range as the source for your chart data. This method might take a bit of getting used to, but it’s incredibly powerful for creating self-updating charts. Another way to maintain dynamic charts
is by using Excel Tables. Tables are a fantastic feature because they automatically adjust as you add or remove data, making them perfect companions for charts. Here's how you can use tables to your advantage: Select your data range and go to the Insert tab. Click on Table. Ensure your range is correct and that your table has headers. Your data is
now formatted as a table. When you create a chart from this table, it will automatically update as you change the table data. Tables not only make your data more manageable but also enhance the dynamic nature of your charts, reducing maintenance time significantly.Bricks makes it easy to analyze data, create dashboards and reports, and get
insights from your spreadsheet data.SIGN UP for free While creating charts is relatively straightforward, there are a few tips that can elevate your charts from good to great. These small tweaks can dramatically improve how your data is perceived. Keep it Simple: Avoid cluttering your chart with too many elements. Stick to what's necessary to
convey your message. Use Color Wisely: Choose colors that are easy on the eyes and ensure they have enough contrast to be distinguishable. Label Clearly: Make sure axis titles and data labels are clear and easy to read. Test Different Chart Types: Sometimes a different chart type can better represent your data. Don’t be afraid to experiment. Be
Consistent: Use the same color scheme and style across multiple charts to maintain consistency. Creating effective charts is as much about clarity as it is about aesthetics, so keep your audience in mind when designing your charts. So, there you have it—a complete rundown on linking data to a chart in Excel. We've covered how to organize your data,
choose the right chart type, and keep your charts updated with dynamic linking. By following these steps, you're on your way to creating insightful and visually appealing charts that can help make informed decisions. And if you're looking to streamline your workflow even further, consider using Bricks. This tool integrates spreadsheets, documents,
and presentations into one seamless platform, with Al capabilities that can automate much of the work for you. Whether it's writing formulas, cleaning data, or creating charts and graphics, Bricks can handle it all in seconds. It’s like having a personal assistant for your spreadsheet tasks, allowing you to focus on what's truly important.header-1-
2header-1-4header-2-4header-3-4header-4-4header-5-4header-1-6header-2-6header-1-8header-2-8Bricks is the Al-first dashboard and reporting tool for spreadsheet data. Create charts, graphs, and analyze your data in seconds - no data analyst needed.Create your first report When working with large datasets in Excel, it is crucial to be able to link a
graph to another worksheet in order to keep your data organized and easily accessible. In this tutorial, we will cover the step-by-step process of creating a link between a graph and another worksheet, allowing you to efficiently manage and update your data. We will cover: Creating a graph in Excel Linking the graph to another worksheet Benefits of
linking data in Excel Key Takeaways Linking a graph to another worksheet in Excel is crucial for organizing and accessing large datasets efficiently. Creating different types of graphs in Excel allows for visualization of data in various formats. Navigating to another worksheet and selecting the specific data range are essential steps in linking data to a
graph. Using the "Edit Data Source" option ensures accurate reflection of linked data in the graph. Having a dynamically linked graph in Excel allows for automatic updates when the source data is changed, providing numerous benefits. Creating a Graph in Excel Excel is a powerful tool for creating and customizing graphs to visually represent data.
Here are the steps to create a graph using the data in a worksheet: A. Steps to create a graph using the data in a worksheet 1. Select the data: First, select the data range in the worksheet that you want to use for the graph. This will typically include both the x-axis and y-axis data. 2. Insert a graph: Go to the "Insert" tab in Excel and select the type of
graph you want to create, such as a bar graph, line graph, or pie chart. 3. Customize the graph: Once the graph is inserted, you can customize it by adding titles, labels, and legends to make it easier to understand and interpret. 4. Format the graph: You can further format the graph by changing the colors, styles, and other visual elements to make it
more visually appealing. B. Different types of graphs available in Excel 1. Column chart: This type of graph is used to compare values across different categories. 2. Line chart: A line chart is ideal for showing trends and changes over time. 3. Pie chart: This circular graph is best for showing the proportion of each data point in relation to the whole. 4.
Bar chart: Similar to a column chart, but with the bars oriented horizontally. 5. Scatter plot: This type of graph is used to show the relationship between two sets of data. Navigating to Another Worksheet When creating a graph in Excel, you may need to link it to data located on another worksheet. Here’s how you can easily navigate to the worksheet
where the data is located. A. How to navigate to the worksheet where the data to be linked is located Click on the worksheet name at the bottom of the Excel window to see a list of all the sheets in your workbook. Scroll through the list and click on the name of the worksheet where the data is located. You will be instantly taken to the selected
worksheet where you can locate and select the data you want to link to your graph. B. Using the worksheet tabs to quickly switch between sheets Instead of scrolling through the list of worksheet names, you can use the worksheet tabs located at the bottom of your Excel window to quickly switch between sheets. Simply click on the desired worksheet
tab to navigate to that specific sheet. This method is especially useful when you have many worksheets in your workbook and need to navigate between them efficiently. Selecting Data for Linking When creating a graph in Excel and linking it to another worksheet, it is crucial to carefully select the specific data range that you want to link to the graph.
Here are the steps to follow: A. Selecting the specific data range to be linked to the graph Step 1: Open the Excel workbook and navigate to the worksheet containing the data that you want to link to the graph. Step 2: Click and drag your mouse to select the specific range of cells that contain the data you want to include in the graph. Ensure that you
select the entire range of data, including the column and row labels, if applicable. Step 3: Once the data range is selected, release the mouse button to finalize the selection. B. Using the "Insert" tab to add the selected data to the graph Step 1: Navigate to the worksheet where you want to create the graph. Step 2: Click on the "Insert" tab in the Excel
ribbon at the top of the screen. Step 3: From the "Insert" tab, select the type of graph you want to create (e.g., bar graph, line graph, pie chart, etc.). Step 4: Once the graph is inserted into the worksheet, click on the graph to select it. Step 5: With the graph selected, navigate to the "Design" and "Select Data" options at the top of the Excel window.
Step 6: In the "Select Data Source" dialog box, click on the "Add" button under "Legend Entries (Series)". Step 7: In the "Edit Series" dialog box, click inside the "Series name" field, then navigate to the worksheet containing the data range you selected earlier. Click and drag to select the entire data range, including the labels, and then click "OK" to
confirm the selection. Step 8: Finally, click "OK" in the "Select Data Source" dialog box to link the selected data range to the graph. Linking the Data to the Graph When working with Excel, it's essential to understand how to link the data to a graph to ensure that the graph accurately reflects any changes made to the underlying data. Here's how you
can do this: A. Using the "Edit Data Source" option to link the data to the graph Open your Excel workbook and navigate to the worksheet containing the graph and the data you want to link to it. Select the graph by clicking on it. Go to the "Design" tab in the Excel ribbon and click on "Select Data" in the "Data" group. Click on "Edit Data Source" to
open the "Select Data Source" dialog box. In the "Select Data Source" dialog box, you can now link the graph to the data by selecting the range of cells that contain the data you want to link to the graph. B. Ensuring that the linked data is accurately reflected in the graph Once you have linked the data to the graph, it's important to ensure that any
changes made to the data are accurately reflected in the graph. Make changes to the linked data in the original worksheet, and then check to see if those changes are reflected in the graph. If the linked data is not accurately reflected in the graph, double-check the range of cells you selected in the "Edit Data Source" dialog box to make sure it
includes all the data you want to display in the graph. Additionally, you can also use the "Change Source" option in the "Select Data Source" dialog box to update the data source for the graph if needed. Updating the Linked Graph Automatically Linking a graph in Excel to another worksheet can be a powerful tool, but it's essential to ensure that the
linked graph updates automatically when the source data is changed. Here's how you can achieve this: A. How to ensure that the linked graph updates automatically when the source data is changed Use named ranges: When creating the source data for your graph, use named ranges instead of cell references. This will allow Excel to automatically
update the graph when the named ranges are modified. Use the OFFSET function: By using the OFFSET function in the series formula for your graph, you can ensure that the graph updates automatically as new data is added or existing data is modified. Utilize dynamic arrays: With Excel's dynamic array formulas, you can create a dynamic range for
your source data, ensuring that the linked graph updates automatically as the dynamic array expands or contracts. B. Benefits of having a dynamically linked graph in Excel Time-saving: With a dynamically linked graph, you won't have to manually update the graph every time the source data changes, saving you time and effort. Accuracy: By ensuring
that the graph updates automatically, you can be confident that the visual representation of the data is always accurate and up to date. Flexibility: Dynamically linked graphs allow for greater flexibility in data analysis, as you can quickly and easily see the impact of changes to the source data on the graph. Conclusion Recap of the steps to link a graph
to another worksheet in Excel: Select the graph in the original worksheet Click on the formula bar and type '=' Switch to the destination worksheet and click on the cell where you want the graph to appear Press Enter to complete the link Final thoughts on the importance of mastering this skill in Excel: Linking a graph to another worksheet not only
helps in organizing your data and presentation but also allows for easy updates and dynamic visual representations. It is an essential skill for anyone working with data and graphs in Excel, and mastering it can significantly improve the efficiency and effectiveness of your work. In and of itself, the process of building Excel charts is pretty
straightforward. However, making some chart elements dynamic with data takes a bit of extra work on your part. And today, you will learn how to harness the power of dynamic chart titles. Basically, the process entails linking an otherwise static chart title to a specific worksheet cell, so whatever you put into that cell will automatically appear as the
new title. That way, the technique does the dirty work of adjusting a chart title for you whenever the underlying data has been altered so that you will never let that small but important detail slip through the cracks—a scenario that, without a doubt, has happened to the best of us at least once. For illustration purposes, consider the following column
chart illustrating the sales figures of a fictitious electronics store for January: To cut to the chase, just follow these simple steps to link your chart title to any cell in the spreadsheet: Click on the chart title. Type “=" into the Formula Bar. Highlight the cell you are going to turn into your new chart title. But that was child’s play compared to what
dynamic chart titles are truly capable of. Now, we will take it to the next level by throwing formulas into the picture so that you can see how powerful the technique truly is. Let’s put together a fancy-looking dynamic chart title that will use both the month and the sales volume data and link it to the chart shown above. Input the following formula into
one of the blank cells (such as A11) and make sure the chart title is linked to that cell: ="Sales Volume in "&A1&": "&TEXT(B9, "#,#")&" Units" In this formula, the TEXT function formats a given value into text, making it possible to use the value as a building block for a dynamic chart title. So, if you are going to use anything other than plain text for
that purpose, check out the tutorial dedicated to the function, which shows in greater detail how to convert different types of data to text. Here are just a few examples of formatting various values into text to be used in building dynamic chart titles: The beauty of this method lies in its flexibility: If you change any of the linked values, the title will be
automatically updated. Still not impressed? Well, let’s turn up the heat even more by adding the sales figures for February and making the chart title display whether the sales went up or down in comparison to the previous month with this formula: ="Sales Volume in "&D1&": "&TEXT(E9, "#,#")&" Units "&IF(E9



